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Introduction
Credit Analysis allows you to analyze credit information for your customers in a 
multi-company setup. You can view and analyze the credit information for a 
selected customer for up to nine companies in a single window.

You must have installed the Collection and Payment Methods - Withholds and Tax 
Listing modules before you can use Credit Analysis.

Check for current instructions
This information was current as of February 2007. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most 
current documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Credit Analysis, and how it integrates with the Microsoft Dynamics™ 
GP system.

To make best use of Credit Analysis, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

• Chapter 1, “Setup,” explains how to set up Credit Analysis. You can set up the 
identification labels and filters for the collection methods.

• Chapter 2, “Inquiry,” describes how to view the credit information for a 
selected customer for the companies that you have set up. You can use this 
information to analyze the credit standing of your customers and take financial 
decisions.

http://go.microsoft.com/fwlink/?LinkID=79222
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently 
displayed, type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.
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U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
You can assign column numbers to the companies for which to analyze credit 
information. You also can assign labels and set up filters to define what information 
will be displayed in the inquiry window.

When you set up Credit Analysis, you can open each setup window and enter 
information, or you can use the Setup Checklist window (Microsoft Dynamics GP 
menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup 
process. See your System Setup Guide (Help >> Contents >> select Setting up the 
System) for more information about the Setup Checklist window.

This information is divided into the following sections:

• Assigning column numbers to companies
• Setting up labels for portfolio checks
• Setting up labels for holds

Assigning column numbers to companies

You can select the companies for which to analyze credit information, and assign a 
column number to each company. You can assign up to three companies to each 
column. This allows you to view credit information for up to nine companies at one 
time.

To assign column numbers to companies:
1. Open the Sort Companies by Column window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Sales >> Credit 
Analysis >> Companies by Column)

2. Select the column number to which to assign a company, or a combination of 
companies.

3. Select a company ID that you have set up in Microsoft Dynamics GP, in the 
Company field. The complete name of the company is displayed next to the 
company ID. You can assign up to three companies to each column.

4. Choose Save to save the information you have entered, or Clear to clear the 
values displayed in the window.

5. Choose Delete to delete the setup for the column displayed.

Setting up labels for portfolio checks

You can set up labels for the rows that display the details for portfolio checks in the 
Query Current Account window. You can also select the statuses for which 
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information is displayed in the inquiry window. You can set up and view the 
combined information for up to three collection method IDs and/ or statuses in a 
single row. Refer to Viewing credit information on page 9 for more information.

To set up labels for portfolio checks:
1. Open the Container Setup Master - Collection/Payment Method window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Sales >> Credit 
Analysis >> Container Setup Master - Collection/Payment Method)

2. Select the row number for which to assign labels in the Container field. 

3. Select the level for the row. You must set up level one for a row before you can 
set up the levels two and three.

4. Enter a label for the row if you are setting up level one.

5. Select a collection method ID for the row - level combination. You can only 
select a collection method ID that has the Use Status checkbox marked. Refer to 
the Collection/Payment Methods- Withholds documentation for more 
information.

6. Select the status of the collection method. All portfolio checks with the selected 
status will be considered for the chosen row- level combination.

7. Choose Save to save the setup you’ve made, or choose Clear to clear the values 
entered. The values you have saved will be available in the scrolling window.

8. Highlight a saved value, and choose Select to bring it to the top row of the 
scrolling window for modification.

9. Choose Delete to delete the setup on the top row of the scrolling window.

Setting up labels for holds

You can define the labels for the rows that display details of documents with holds 
in the Query Current Account window.
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To set up labels for holds:
1. Open the Suspension Container Setup Master window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Sales >> Credit 
Analysis >> Suspension Container Setup)

2. Select the row number for which to assign labels in the Container field.

3. Select the level for the row. You must set up level one for a row before you can 
set up the level two.

4. Enter a label for the row if you are setting up level one.

5. Select a sales process hold ID for the level in the Suspension ID field. 

6. Select the status for the suspension ID, whether Assigned or Removed.

7. Choose Save to save the set up you’ve made, or choose Clear to clear the values 
entered. The values you have saved will be available in the scrolling window.

8. Highlight a saved value, and choose Select to bring it to the top row of the 
scrolling window for modification.

9. Choose Delete to delete the setup displayed on the top row of the scrolling 
window.
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Chapter 2: Inquiry
You can view the credit information for a selected customer for up to nine 
companies that you have set up in Microsoft Dynamics GP. You can view the aging 
period balances for transactions entered. You can also view the details for portfolio 
checks, and for documents that have sales process holds assigned.

This information is explained in the following section:

• Viewing credit information

Viewing credit information

Use the Query Current Account window to view and analyze credit information for 
a selected customer.

To view credit information:
1. Open the Query Current Account window.

(Cards >> Sales >> Summary >> Additional >> Credit Analysis)

2. Enter or select a customer ID. The customer’s name is displayed next to the 
customer ID field.

3. The column header fields display the names of the companies that you have 
included in each column. Click the expansion button to view the column 
information that you have set up. Refer to Assigning column numbers to companies 
on page 5 for more information.

4. The first section displays the aging period credit information for transactions. 
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5. The second section displays the credit information for payments received 
through portfolio checks. This information is displayed on the basis of the labels 
and statuses you have assigned in the Container Setup Master - Collection/
Payment Method Setup window. Refer to Setting up labels for portfolio checks on 
page 5 for more information.

6. The third section displays the information for documents that have sales 
process holds applied. This information is displayed based on the labels and 
statuses you have assigned in the Suspension Container Setup Master window. 
Refer to Setting up labels for holds on page 6 for more information.

7. Choose OK to close the window.
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